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REZUMAT 

Scopul acestui studiu a fost acela de a oferi o unealtă
utilizată în comunicarea mediată de computer (CMC) 
precum şi în sprijinirea experiențelor educaționale pe 
calculator. Acest studiu se bazează pe un model numit  
comunitate de interes (“community of inquiry”) ce constă
în trei elemente esențiale ale unui proces educaţional: 
prezenţa cognitivă, socială şi educativă. Indicatori 
(cuvinte, expresii) pentru fiecare dintre cele trei elemente 
se obțin în urma analizei textelor. Acești indicatori 
reprezintă șabloane pe care cercetătorii le folosesc pentru 
a analiza niște comunicări scrise, dar şi pentru a ghida 
personalul didactic spre a utiliza conferințele 
computerizate cât mai eficient, ca pe un mediu ce 
facilitează dezvoltarea educației. Prin acest studiu se 
demonstrează că orice conferință computerizată are 
potențialul de a crea o comunitate cu scopuri educaționale.  

Cuvinte cheie 

Prelucrarea Limbajului Natural, Inteligenţă Artificială, 
Forum, Comunicarea Mediată de Calculator, CSCL 

Clasificare ACM 

I.2.7 Natural Language Processing, K.3.1 Collaborative 
Learning  

INTRODUCERE 

Unul dintre principalele motive pentru care universităţile 
optează pentru învăţământul la distanţă este 
democratizarea accesului la educaţie al oamenilor ce 
provin din medii dezavantajate. Când s-a introdus            
e-learning, sau e-învățarea (e-educația), același motiv a 
justificat procesul. Un atribut important al tehnologiilor 
folosite este capacitatea lor de interacţiune în timp real.  

Mult timp s-a crezut că procesul de e-educație constă în 
transpunerea în format digital a unui curs predat în clasă, 
ce poate fi apoi trimis unui număr oricât de mare de elevi, 
fără prea multă implicare din partea profesorilor. Această
perspectivă nu se apropie deloc de adevăr, deoarece nu 
corespunde sensului educaţiei. Simpla publicare a 
cursurilor nu înlocuieşte procesul de educaţie, ci doar face 
parte din acesta, fiind completată de interesul şi dedicaţia 
profesorului, precum şi de colaborarea între acesta şi elevi 
sau doar între elevi.  

Comunicarea mediată de calculator (CMC) se remarcă
între metodele de educaţie la distanţă din cauza capacităţii 
de a suporta nivele înalte de interacţiune între facultate şi 
studenţi, în acelaşi timp oferind libertate în timp şi spaţiu 

pentru implicare [10]. Indiferent de semnalele folosite, 
informaţia trebuie transmisă interactiv între sursă şi 
destinaţie, între student şi profesor, studenţi şi studenţi sau 
către studenţi [14].  

Comunicarea mediată de calculator este definită ca orice 
formă de comunicare interpersonală ce se produce cu 
ajutorul unei reţele formate din două sau mai multe 
calculatoare. Cercetările în CMC se axează în special pe 
efectele sociale pe care le au diferite tehnologii de 
comunicare cu ajutorul calculatoarelor. Multe studii 
recente iau în considerare faptul că reţelele sociale bazate 
pe Internet sunt în strânsă legătură cu softurile sociale.  

Multe instituţii de învăţământ superior folosesc sau 
intenționează să folosească CMC, în special conferinţele 
în mod text, considerându-le un mediu capabil pentru 
distribuţia programelor educaţionale, oriunde, oricând. În 
timp ce dezvoltatorii acestui nou mediu sunt convinşi de 
potenţialul său, nici efectele asupra calităţii procesului de 
învăţare, nici rezultatele sale, nu au fost încă bine studiate. 

Cum CMC au început să fie folosite în scopuri cât mai 
diferite şi inovative în domeniul educației, şi nu numai, a 
apărut şi nevoia prelucrării acestora, dar în timp ce 
numărul instrumentelor de colaborare pe Web, precum şi 
utilizarea acestora, creşte tot mai mult în fiecare an, ne 
confruntăm cu problema analizei acestora şi extragerii 
informațiilor din ele. În acest scop un rol important îl are 
prelucrarea limbajului natural.  

SCOPUL LUCRĂRII 

Conferințele computerizate au devenit tot mai utilizate în 
ultimii ani, mai ales datorită posibilităţii de a simula 
conversațiile “faţă în faţă” într-un spațiu virtual. Conform 
studiilor, printre beneficiile conferințelor computerizate ar 
fi: confortul, independenţa spațială şi temporală, 
posibilitatea utilizatorilor de a face parte dintr-o 
comunitate virtuală [2].  

Dacă prin învăţarea colaborativă studentul este cel mai 
avantajat participant, pentru profesor predarea online 
necesită cel puțin același efort ca şi predarea într-o sală de 
clasă. Acesta trebuie să pregătească materialele, să le facă
disponibile pe calculator, să-i motiveze şi să-i ghideze pe 
studenți printr-o interacțiune continuă, la distanţă. Deși 
atât studenților, cât şi profesorilor le este permis să
participe la cursuri şi să lucreze din orice locație, şi în 
intervale mari de timp, efortul depus de profesor pentru 
fiecare elev în parte creşte semnificativ, mai ales când 
apare problema evaluării. Profesorul ajunge în situația de a 
evalua participarea fiecărui elev într-o comunicare online, 



Ș.Trăușan-Matu, D.Tufiș (eds.), RoCHI 2011 

18 

ce poate ajunge la dimensiuni considerabile. Simpla 
parcurgere a contribuției fiecărui participant necesită
foarte mult timp şi concentrare din partea profesorului.  

Această lucrare urmărește dezvoltarea unei aplicații care 
să ajute profesorul să evalueze participarea unui student la 
un forum de discuții. Printre avantajele acestei aplicații de 
precizat ar fi în special reducerea timpului şi creșterea 
eficienţei.  

Aplicația folosește modelul comunitaţii de interes 
(Comunity of Inquiry), pentru a identifica în fiecare mesaj 
dintr-un forum prezenţele sociale, educative sau cognitive 
ale autorului. Prin ea se doreşte să se încurajeze utilizarea 
CMC în scopul realizării obiectivelor educaționale putând 
fi folosită pentru a analiza diverse strategii educaționale şi 
efectul acestora asupra elevilor şi studenților. 

PROIECTE SIMILARE 

Datorită necesității de a extrage informații din diverse 
comunicări verbale sau textuale, au apărut mai multe 
proiecte cu scopuri similare, majoritatea dorind să
detecteze prezenţa emoţiilor. Mai multe companii ca Right 
Now Technologies sau NICE Systems au produs aplicaţii 
precum SmartSense™ sau NICE Perform™ care recunosc 
emoţiile folosind tehnici de detecţie a cuvintelor cheie, 
apoi marchează, prioritizează şi dirijează investigaţiile, 
bazându-se pe conţinutul emoţional.  

Tot în domeniul detecției emoţiilor se remarcă şi agentul 
care preia știri de la diverse resurse, clasificând titlurile în 
opt categorii de emoții, folosind interpretoare semantice şi 
SenseNet [12].  

Un alt studiu [8] folosește un program de învăţare 
automată, numit BOOSTEXTER să clasifice automat 
emoții. BOOSTEXTER este un program destinat 
clasificării de texte. Acesta folosește un algoritm de 
stimulare, ce formează o clasificare ipotetică combinând 
rezultatele mai multor iterații [11].  

Un grup de cercetare de la Universitatea din Illinois a 
dezvoltat un soft numit Semantic Role Labelling [15] ce 
identifică verbul şi structura argumentului într-o 
propoziție. Acesta a fost utilizat, alături de un motor de 
căutare (Google), în continuare cu scopul detecției 
emoțiilor, încercând în același timp o înțelegere a textului 
[16]. Din păcate Google nu furnizează mereu informațiile 
așteptate (exemplu: war + happy are mai multe rezultate 
decât war + sad) şi de multe ori rezultatele nu sunt cele 
corecte.  

E-rater este un program pentru notarea automată a 
eseurilor, dezvoltat de ETS (Educatonal Testing Service) 
şi inaugurat în 1999, ajungând în prezent la versiunea v.2. 
Inițial a fost folosit pentru notarea testelor GMAT 
(Graduate Management Admission Test), necesare pentru 
admiterea la programele de masterat. Programul 
analizează exemple de scris, sintaxă, topologie, discurs şi 
vocabular. Eseurile ce trebuie notate sunt comparate cu un 
set de învăţare ce conține sute de eseuri scrise corect, 
fiecare set corespunzând unei întrebări. Cum programul se 
bazează pe un set de test, el nu poate să înţeleagă sau să
decidă dacă textul este coerent, sau dacă ceea ce este scris 
are sens. Deși versiunea v.2 este cu mult superioară celei 

din 1999 şi rezultatele sunt foarte bune, programul nu face 
conexiuni logice şi nu aduce argumente. 

MODELUL ”COMUNITY OF INQUIRY” 

Interacțiunea este considerată esențială în învăţarea 
experiențelor din perspectiva constructivistă socioculturală
[13], ceea ce presupune că membrii unei comunităţi ce 
participă într-o comunicare îşi dezvoltă mai mult 
cunoștințele. În plus, capacitatea de dezvoltare intelectuală
a elevului (a celui care învaţă) se consideră a fi sporită de 
prezenţa unei ghidări, reprezentate de un tutore/coleg, prin 
interacțiune. În contextul educației online, sau e-educației, 
schimbarea mediului de la educația tradițională, în sala de 
clasă, la una plasată intr-un spațiu virtual, prezintă
numeroase beneficii şi provocări pentru pedagogi, întrucât 
interacțiunile nu mai sunt limitate de decizii tehnologice.  

În 1989 Moore a introdus trei tipuri de interacțiune, acum 
cunoscute la scară largă şi acceptate în domeniul 
învăţământului la distanţă: cursant – conținut, cursant – 
instructor şi cursant – cursant.  

Datorită optimizărilor tehnologiilor web/CMC, 
interacțiunea cursant – cursant reprezintă o nouă
dimensiune pentru învăţământul la distanţă, ce ocolea de 
obicei grupurile/abordarea învăţării colaborative datorită
separării geografice a participanților.  

Dezvoltând aceste trei clase de interacțiune, Anderson şi 
Garrison [17] au sugerat că orice comunicare online ar 
trebui să se desfăşoare între cele trei macro-componente: 
cursantul, instructorul şi conținutul, creând astfel tipurile: 
interacțiune cursant – conținut, cursant – instructor şi 
instructor – conținut. În plus, comunicarea din interiorul 
fiecărei macro–componente poate determina un subset de 
interacțiuni: cursant – cursant, instructor – instructor şi 
conținut – conținut. Pentru a obține un context pentru 
aceste interacțiuni, Garrison, Anderson şi Archer [17] au 
creat modelul Community of Inquiry, care a fost elaborat şi 
explicat în publicațiile ulterioare: Anderson, 2004; 
Garrison, 2003; Garrison şi Anderson, 2003; Kanuka şi 
Garrison, 2004 etc.  

Figura 1. Mediul de comunicare intr-o comunitate de interes 
[4] 

Precum se observă în Figura 1, o experiență utilă de 
învăţare este cuprinsă într-o comunitate de interes 
compusă din profesori şi studenți, participanții esențiali 
într-un proces educațional. Modelul presupune că
învăţarea se realizează în interiorul comunităţii prin 
interacțiunea celor trei elemente. În aceeași figură sunt 
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prezentate cele trei elemente esențiale: prezenţa socială, 
cognitivă şi educativă.  
În analiza conferințelor folosite pentru scopuri educative, 
se caută mesaje sau segmente din acestea, care arată că
aceste trei elemente esențiale sunt prezente, adică se caută
indicatori ale celor trei elemente. Acești indicatori sunt 
reprezentați de anumite fraze, cuvinte cheie, sau sinonime 
ale acestora. Pentru o structurare mai ușoară acești 
indicatori au fost grupați în subcategorii care indică mai 
clar aspectul fiecărui element ce este reprezentat de fiecare 
grup de indicatori [ 5]. 

Prezenţa Cognitivă este măsura prin care elevii sunt 
capabili de a construi şi confirma sensul, susținând 
reflecția şi discursul [4].  

Tabelul 1. Indicatori prezenţă cognitivă

Definirea 
Categoriilor 

Cod Indicatori 

Declanşare 
Eveniment 
(Triggering 
Event)

conceptualiza
rea inițială a 
unei probleme 

cte Recunoașterea unei probleme, 
probabil din experiență, 
exprimarea nedumeririi sau 
disconfortului, întrebări, cererea 
explicațiilor  
e.g.”I am not quite sure what 
[…] is about – should we start 
by clarifying what we mean 
by[…].” 

Explorare 
(Exploration) 

 încercarea de 
a găsi sensul 
unei probleme 

ce Schimb de  informații, clarificări 
de situații sau termeni, 
discutarea ambiguităţilor, 
căutarea explicațiilor; 
caracterizat de schimbarea 
informațiilor;  
e.g. “I think this is an interesting 
topic, but others have a different 
perception of it, to mine and we 
have to take this into account” 

Integrare 
(Integration)  

conectarea 
ideilor şi 
începerea de a 
lega concepte, 
ce duce la 
găsirea de 
explicații  

ci Integrarea cunoștințelor şi ideilor 
în explicații coerente; testarea 
posibilelor intuiții asupra 
problemelor  
eg “I observed all types of 
behaviors on the hospital wards, 
but you have to reflect on the 
reasons why people behave as 
they do in order to […]and the 
easiest course of action is not 
always the best”. 

Rezoluţie 
(Resolution)  

estimarea 
soluțiilor 
problemelor  
(Prioritate 
maximă)  

cr Reflectarea asupra eficienţei 
soluțiilor sau dilemelor, 
explorarea consensurilor, a 
înțelegerilor sau a diferențelor  
eg “Perhaps the best way of 
approaching this problem is not 
by […], but by asking questions 
in such a manner […], which 
would improve inappropriate 
practices by […] by making 
them think about their actions”. 

În cadrul prezenţelor cognitive, deși fiecare subcategorie 
are o prioritate (cea mai mica pentru declanşarea 

evenimentelor si cea mai mare pentru rezoluţie), uneori 
mai multe apariţii ale unei categorii cu prioritate mai mică
pot să depășească în importanţă o categorie cu prioritate 
mai mare, dacă acest lucru este mai relevant (Dacă cr = 6, 
ci = 4, ce = 3, cte = 2 şi o propoziție poate primi adnotarea 
cr sau 3*ce, ar fi de preferat să alegem ce).  

Prezenţele sociale şi educative nu includ o ierarhie, așa că
putem avea oricâte instanțe ale fiecare subcategorii.  

Prezenţa Socială este capacitatea participanților de a se uni 
şi identifica cu comunitatea, de a-şi comunica intențiile 
într-un mediu de încredere şi de a dezvolta relaţii 
interpersonale printr-o metodă prin care îşi expun propriile 
personalităţi unice [5].  

Tabelul 2. Indicatori prezenţă socială

Definirea 
Categoriilor 

Cod Indicatori 

Expresie 
emoțională
(Emotional 
Espression)  

indică
sentimentul de 
siguranță într-un 
mediu online 

see Împărtăşirea expresiilor şi a 
trăirilor, atât exprimarea 
convențională, cât şi 
neconvențională a emoțiilor, a 
umorului, ironiei şi 
deschiderea spre auto-
dezvăluire ce indică
vulnerabilitate. e.g. “I was so 
angry[…] I could not 
understand him[…]”. 

Comunicare 
Deschisă (Open 
Communication)  

soc Recunoașterea altor 
participanți şi a contribuției 
acestora, încurajarea 
participanților în legătură cu 
mesajele lor  
eg “In your last message you 
referred to[…].” I really 
liked your interpretation of 
that situation” 

Colaborare în 
Grup (Group 
Collaboration)  

sgc Încurajarea interacțiunii în 
grup, acceptând diferențe de 
opinie, indicate de adresarea 
cu “we”(noi), referirea la 
participanți cu ajutorul 
numelor,, folosind “our”  
eg “I think that John 
summarised our discussions 
very well..” 

Prezenţa Educativă este proiectarea, facilitatea şi direcția 
proceselor cognitive şi sociale având ca scop realizarea 
rezultatelor învăţării într-un mod semnificativ din punct de 
vedere personal şi al meritelor educaționale [1]. 

O problemă a aplicației este greutatea identificării 
prezenţelor educative, ale profesorului. O soluție simplă ar 
fi fost alegerea persoanelor cu rol de tutore, sau 
identificarea lor cu prima persoană care postează, dar ar fi 
putut apărea neconcordanţe in cazurile cu mai mulți 
îndrumători. 
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Tabelul 3. Indicatori prezenţă educativă

Definirea 
Categoriilor 

Cod Indicatori 

Managementul 
Instrucţiunilor 
(Instructional 
Management 

crearea de 
structuri de 
bază  

tim Facilitează dezvoltarea 
organizării în cadrul grupului, 
inițiind discuţii, setând reguli 
sau etichete eg “In our inițial 
face to face meeting we decided 
to deal with….” “We must finish 
this discussion by Friday…” 

Instruire 
Directă (Direct 
Instruction)  

ţine pasul cu 
discuția, 
confirmă că
grupul a 
înţeles,  
răspunde la 
probleme 
tehnice 

tdi Înțelege când grupul a ajuns la 
un punct critic şi îl ajută să îl 
depăşească, folosind cunoștințe 
din afară şi alte referințe pentru 
a menține discuția aprinsă, 
răspunzând la probleme tehnice  
eg. ”If you want to upload an 
attachment just 
click on….” 

Construirea 
Discursurilor şi 
a înțelegerilor 
în grup  
(Group 
Cohesion) 

tbu Facilitează colaborarea în grup, 
identificând acordul sau 
dezacordul, asigurând un mediu 
pentru discuție, făcând rezumate, 
folosind întrebări-cheie pentru a 
dezvolta discuția, confirmând 
comentariile interesante de la 
alți participanți, încurajând pe 
toți să participe  
eg ‘Any thoughts on this issue?’ 
‘Anyone care to comment?’ ‘I 
think we’re getting a little off 
track.’ 

Potrivit lucrării lui Garrison şi Anderson [4], termenul 
“Community of inquiry” a fost folosit pentru prima dată
de Lipman [7] referindu-se la o comunitate facilitată de 
profesori, unde studenţii îşi asculta colegii cu respect, 
rezultat din exprimarea opiniilor personale, se provoacă
unii pe alții pentru a obține motive pentru opinii contrare, 
care în alt context nu ar fi fost acceptate, se ajuta reciproc 
în obținerea concluziilor la ceea ce a fost spus, şi caută să-
şi identifice şi clarifice reciproc ipotezele [7]. Bazându-se 
pe acest concept larg de comunitate educațională, care 
cuprinde studenți şi profesori, şi pe ipoteza constructivistă
că formarea de cunoștințe este un proces social 
contextualizat, care se desfășoară într-o asemenea 
comunitate, modelul Community of inquiry este conceput 
astfel încât să cuprindă trei elemente ce interacționează
între ele şi se consolidează: prezenţa social (social 
presence), prezenţa cognitivă (cognitive presence) şi 
prezenţa educativă (teaching presence). Acestea sunt 
dezvoltate în mediile de instruire online prin tehnologii 
CMC (mediate de calculator). Formarea unei astfel de 
comunităţi în contextul învăţării online reprezintă un 
mediu pentru ”discurs critic şi reflecție” [5], unde 
experiența educației bazate pe dialog, de a împărtăşi şi 

negocia atât ceea ce este cât şi ceea ce nu este înțeles, 
poate conduce la ”niveluri mai ridicate de învăţare” [10]. 

APLICAŢIA 

Aplicația realizată are scopul de a analiza discuții online, 
şi de a evalua participarea studenților la acestea. Inițial 
programul a fost aplicat pe forumurile de discuții ale 
studenților de la Facultatea de Medicină din Manchester. 
În urma studiului asupra acestor forumuri s-a ajuns la 
concluzia că modelele descrise anterior pot fi identificate 
în funcție de anumite şabloane. 

Pentru a implementa aplicația au trebuit considerate mai 
multe elemente: interfaţa grafică, care ar trebui să fie cât 
mai simplă, intuitivă şi ușor de utilizat, şi modulele apelate 
de aceasta cu rolul detecției celor trei tipuri: prezenţă
socială, cognitivă şi educativă, din modelul comunităţii de 
interes (Community of Inquiry), conectate prin structura 
Forum. 

Programul se bazează pe un sistem de reguli prin care se 
identifică într-o serie de mesaje din forumuri prezenţele 
sociale, educative şi cognitive, căutând şabloane fixe in 
text, pentru a putea evalua participarea studenților la 
discuție. Studenţii care prezintă toate tipurile de prezenţe: 
socială, cognitivă şi educativă sunt cei care se implică mai 
mult în conversaţie. Cele trei tipuri diferite de prezenţe fac 
posibilă o analiză mai complexă a mesajelor, pentru a nu 
considera cele mai implicate acele persoane care discută
mult pe teme irelevante subiectului de tratat. Acestor 
persoane sunt favorizate acelea care se implică in 
conversație din toate aspectele (social, cognitiv şi 
educativ).  

Figura 2. Use-case

Pentru a rula aplicația, este nevoie doar de o mașină
virtuală Java. Comunicarea cu interfața este cât se poate 
de intuitivă:  
File->Open: citește datele dintr-un XML ce conține 
diverse mesaje în forumuri şi afișează informațiile într-un 
tabel în primul tab, numit sugestiv, Forums. 

File->Save: opțiunea este dezactivată în lipsa 
modificărilor asupra tabelului, iar când este activă
salvează noul tabel.  

File->Exit: iese din aplicație  

Edit->Run: adaugă în ultima coloană adnotările calculate  

Dintre coloanele tabelului din primul tab, se poate 
modifica doar cea cu adnotările citite din XML, putându-
se seta oricare dintre adnotări. Al doilea tab permite 
afișarea pentru un anumit mesaj. Selectând un anume 
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mesaj din tabel, prin click pe ID, în al doilea tab se poate 
vizualiza textul şi adnotările calculate. Prin selectarea unei 
opțiuni din lista de RadioButtons (unde putem alege o 
subcategorie din modelul Community of Inquiry) şi 
apăsarea butonului “Ok”, propozițiile în care s-a 
identificat aceasta categorie sunt evidențiate cu font de 
culoare roșie. 

Figura 3. Diagrama claselor  

Într-o primă instanță, utilizatorul nu poate decât să închidă
aplicația sau să citească forumuri. Open declanșează
citirea din XML, prin constructorul Forums() care 
populează lista de forumuri.  

Forum este clasa principală a aplicației, ce reprezintă un 
mesaj pe forum. Forums este o colecție de obiecte de tip 
Forum. Fiecare astfel de Forum are un număr de 
identificare unic, un autor, subiect, text, adnotări preluate 
din XML şi adnotări calculate. Textul este împărţit într-o 
lista de propoziţii: sentences. Rezultatele obținute în urma 
adnotărilor automate se păstrează intr-un HashMap, 
annotations, ce asociază fiecărei categorii un Vector de 
MyMatch-uri.  

Căutarea propriu-zisă este realizată cu ajutorul clasei 
PatternSearch, apelând metoda rezolva() care întoarce un 
vector de potriviri (Match). O potrivire conţine indice, 
expresia căutată şi textul în care a fost găsită expresia. 
Clasele sunt destinate lucrului cu chat-uri.  

Aceste clase au fost modificate pentru a corespunde 
cerințelor, şi se aplică pe propoziții, întorcând o singură
subcategorie de un anumit tip pentru o propoziție dată, 
întrucât am considerat că nu putem avea mai multe 
instanțe. Noua clasă MyMatch va corespunde potrivirii 
făcute între o expresie şi o propoziție. Vectorii de 
MyMatch-uri întorși de metoda rezolva() sunt parcurși 
pentru a elimina instanțele duble şi a fi memorați în 
HashMap-ul fiecărui forum în parte.  

Interfața cu utilizatorul este simplă, intuitivă, pentru a 
putea fi folosită de oricine. Aceasta conține un meniu, cu 
câteva sub-meniuri şi un TabbedPane cu două taburi. 

Tabelul (jTable1) are coloane de tip nr întreg (ID), text 
(Utilizator, Subiect, Conţinut) sau panel. A cincea 
coloană, cea cu adnotările citite din XML conține un tabel 
cu 3 linii şi 3 coloane, conținând categoriile din prezenţele 
sociale şi educative, şi numărul aparițiilor, şi un panel cu 
RadioButtons – categoriile de prezenţă cognitivă. 

Figura 4. Citirea datelor 

Utilizatorul poate modifica adnotările citite din fişier, 
selectand pe rand mesajele si apoi categoriile dorite.   

Figura 5. Selecţia 

Al doilea tab conține un label, unde va fi afișat textul 
forumului, o serie de RadioButtons şi un TextArea, ce va 
conține adnotările. Selectând o categorie de prezenţă
socială, educativă sau cognitivă, la apăsarea butonului Ok, 
în label propoziția în care aceasta a fost identificată se va 
colora cu font roșu. Acest lucru este posibil prin setarea 
textului corespunzător label-ului în format HTML. Tot 
aici a fost definită o metodă de extindere (wrapLabelText) 
a textului pe label, pentru a putea afișa mai multe rânduri 
de lăţime fixă. 

Figura 6. Evidenţiere categorii selectate 
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Figura 7. Evidenţierea prezenţei cognitive 

Pentru a determina categoriile din modelul lui Garisson, 
corespunzătoare fiecărui mesaj al forumului am ales să
adnotez fiecare propoziție din textul postat pe forum. 
Astfel, o propoziție poate să fie marcată cu o singură
subcategorie a prezenţelor sociale, educative şi cognitive. 
În final, dintre prezenţele cognitive identificate pe un 
mesaj se alege una singură, în funcție de prioritate şi 
cantitate.  

Pentru a lucra mai bine cu propoziții şi cuvinte, mai ales 
datorită faptului că aplicația se bazează pe recunoaștere de 
şabloane, am apelat la WordNet.

WordNet [9] este o bază de date lexicală interactivă, o 
ontologie lexicală, electronică, considerată în momentul 
de faţă cea mai importantă resursă pusă la dispoziția 
cercetătorilor în lingvistica computațională, analiza de 
texte şi alte domenii similare. Aceasta a fost dezvoltată de 
un grup de cercetători de la Universitatea Princeton, 
conduși de George Miller [3]. WordNet poate fi privit ca 
un dicționar semantic deoarece cuvintele sunt localizate pe 
baza afinităților conceptuale cu alte cuvinte, spre 
deosebire de cazul dicționarelor, unde găsim cuvintele în 
ordine alfabetică. În această bază de date se pot găsi 
majoritatea cuvintelor limbii engleze (substantive, 
adjective, verbe şi adverbe), organizate în mulțimi de 
sinonime numite synset-uri. Fiecare dintre aceste synseturi 
reprezintă un concept, ceea ce ne duce la concluzia că
WordNet organizează informația lexicală în termeni de 
sensuri ale cuvintelor. Cuvintele polisemantice aparțin mai 
multor synseturi. WordNet face legătura între formele 
cuvintelor şi sensurile lor, folosindu-se de categoria 
lexico-gramaticală (clasa morfologică) pentru a grupa 
termeni cu același interes în același synset.  

În această aplicație WordNet este folosit în detalierea şi 
identificarea şabloanelor din setul de reguli, pentru a face 
posibilă o căutare evoluată. 

REZULTATE 

Aplicația a avut rezultate foarte bune în special pentru 
prezenţele sociale şi cognitive, probleme apărând mai ales 
la prezenţele educative, datorită şabloanelor alese, care 
sunt destul de ambigue. Rezultatele se pot vedea în tabelul 
de mai jos. Acesta a fost realizat în urma analizei a 400 de 
mesaje postate pe forumuri.  

Pentru centralizarea rezultatelor am considerat că un 
forum a fost adnotat corect dacă prezintă aceleași subtipuri 
de categorii (see, soc, sgc, tim, tdi, tbu, si, ce, cr, cte) cu 
datele citite din XML. Diferențe apar de obicei datorită
faptului că unele persoane au adnotat paragrafe şi nu 
propoziții sau au considerat un singur item de o anumită

categorie pentru două, sau mai multe, propoziții 
consecutive de același tip. 

Figura 8. Rezultate eficienţă

Al doilea studiu a fost efectuat pe 40 de mesaje adnotate 
după teoria de la 3.2, cu specificația că fiecare propoziție 
poate fi descrisă de aceste categorii. Rezultatele au fost 
considerate corecte pentru erori mai mici de 10%.  

De remarcat este faptul că analiza este independentă de 
conținut: indiferent de subiectul conversației, 
performanţele rămân constante. 

În urma rulării programului pentru aproximativ 400 de 
mesaje din forumuri şi cu o listă considerabilă de şabloane 
de identificare, obținute în urma analizei textelor, s-a ajuns 
la concluzia că acesta necesită destul de mult timp pentru 
a adnota textele, în ciuda eforturilor depuse pentru a 
ameliora timpii de execuție. Avantajul este că, spre 
deosebire de oameni, programul nu obosește şi 
performanţele sale sunt constante în timp.  

A fost realizat un studiu pe cinci persoane (studenţi la 
Facultatea de Medicină) pentru a compara performanţele 
programului. Fiecare a trebuit să adnoteze câte 40 de 
mesaje din forumuri, având la dispoziție descrierile de la 
capitolul 3.2. S-a ajuns la concluzia că timpul necesar unei 
persoane de a face această analiză este cu mult mai mare, 
deoarece pentru numai 40 de mesaje s-a obținut un timp 
de aproximativ 10 de ori mai mare decât cel necesar 
programului pentru un număr de zece ori mai mare de 
mesaje. În plus, după primele 10-15 mesaje toți 
participanții la studiu au cerut o pauză motivând probleme 
de vedere şi oboseală. La cei care au adnotat aproximativ 
30 de forumuri fără pauză au apărut multe erori în 
prelucrarea datelor, categoriile alese fiind de multe ori 
inexistente în textele respective.  

În plus, este suficient ca programul să fie rulat o singură
dată pentru a determina categoriile pentru fiecare forum, 
după care evaluarea se face foarte ușor apelând la 
rezultatele păstrate în obiectele de tip Forum. 

OBSERVAŢII 

De remarcat şi notat este faptul că două persoane diferite 
nu pot adnota în același mod același text, deoarece 
oamenii sunt foarte subiectivi. De multe ori adnotările 
citite din XML nu s-au potrivit analizei efectuate de cele 
cinci persoane testate pentru subcapitolul anterior. Această
subiectivitate este rezultată din faptul că un om citește 
textul şi alege categoriile în funcție de înţeles. Din 
moment ce încă nu s-a dezvoltat un algoritm de inteligenţă
artificială care să poată înţelege un text, acest lucru nu este 
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posibil de făcut în cadrul unei aplicații. Metoda aleasă
(sistem bazat pe reguli) întoarce rezultate foarte bune 
pentru scopul analizei.  

Se poate observa că persoanele în ale căror intervenții pe 
forum se pot identifica toate cele trei categorii: prezenţa 
socială, prezenţa cognitivă şi prezenţa educativă, 
indiferent de numărul acestora, sunt acelea cu o activitate 
cât mai productivă. În cadrul unei evaluări a participării 
fiecărui participant la forum aceste persoane vor avea 
punctaje cât mai mari. În zona de dezvoltare comună a 
celor trei elemente independente se creează o experiență
de învăţare profundă. Deși elementul cheie ce stă la baza 
procesului de învăţare este cel cognitiv, prezenţa celorlalte 
denotă faptul că studentul respectiv se implică în discuție, 
şi are șanse mari să se dezvolte mai mult, deoarece 
forumurile sunt folosite în scopul învăţării colaborative. 

CONCLUZII 

CSCL dorește să ajungă la o construire colaborativă a 
cunoașterii [15] prin susținerea şi ajutarea tuturor elevilor 
sau studenţilor să înveţe eficient împreună. Se încurajează
ideea comunicării ideilor şi informațiilor între studenți, a 
accesării colaborative a informațiilor şi documentelor, şi a 
feedbackului constant de la colegi şi tutore. CSCL sprijină
activităţile în grup şi dinamica grupului, în moduri ce nu 
pot fi aplicate în comunicarea faţă în faţă.  
Cercetătorii au demonstrat că învăţarea colaborativă are un 
rol foarte important în educație şi în dezvoltarea personală
a participanților. Dacă învăţarea colaborativă reprezintă
ideea de a forma grupuri care să lucreze şi să înveţe 
împreună, într-un mod colaborativ, atunci uneltele folosite 
de învăţarea colaborativă sprijinită de calculator îşi 
îndeplinesc sarcina fie sincron, fie asincron. Astfel 
chaturile, forumurile, blogurile nu sunt folosite doar 
pentru relaxare şi distracție, ci şi în scopuri educative. 
Spre deosebire de sala de clasă, mediul virtual este de 
multe ori privit cu mai multă încredere şi simpatie. Totuși, 
CSCL înseamnă Computer-Supported Collaborative 
Learning, iar procesul de educație (“learning”) nu 
presupune doar avantaje pentru elevi sau studenți, întrucât 
la fel de implicat în acest proces este şi profesorul. CSCL 
ar trebui să aducă avantaje pentru toți participanții la 
procesul de educație. În concluzie, şi profesorul ar trebui 
să aibă parte de o uşurare sau evoluare a muncii, datorată
folosirii calculatoarelor (“Computer-Supported”) şi în 
ajutorul lui vin aplicațiile de inteligenţă artificială. 
Rolurile tutorelui în CSCL, precum şi responsabilitățile 
sale cresc foarte mult, deoarece el nu se mai poate exprima 
la fel de ușor, şi nu poate să apeleze la gesturi, mimică sau 
tonalitate. El va trebui să aibă grijă să inspire încredere 
pentru a insufla cursanţilor dorința de a învăţa pe cont 
propriu, să animeze grupul de care este responsabil, 
incitând toţi membrii să realizeze raporturi virtuale, să
motiveze elevii în a găsi cele mai potrivite strategii şi 
metode de învăţare, să identifice şi să rezolve 
neînțelegerile sau problemele lor, să le răspundă la 
nelămuriri şi să livreze feedback legat de progresele 
realizate etc.  

În cadrul unui sistem bazat pe comunicare este bine de 
știut cât de mult se implică fiecare participant în 
colaborare. Am prezentat în capitolele precedente ce 
înseamnă învăţare colaborativă, ce avantaje aduce aceasta 
şi ce rezultate au fost înregistrate. Adevărul este că, într-un 
sistem colaborativ în care colaborarea este la un nivel 
minim, niciunul dintre aceste rezultate nu poate fi atins. 
De aceea este foarte important să analizăm gradul de 
participare al fiecărui membru la discuție.  

Lucrarea de faţă îşi propune nu doar să găsească
alternative teoretice de rezolvare, ci şi să aducă o 
implementare a acestora, care să vină în sprijinul 
profesorilor sau cercetătorilor. Aplicația şi-a atins scopul, 
putând să identifice prezenţe sociale, cognitive sau 
educative în diverse mesaje de pe forumuri, făcând 
posibilă analiza contribuției fiecărui participant.  

Aplicația poate fi îmbunătăţită din mai multe puncte de 
vedere. Interfața ar putea să cuprindă mai multe modalităţi 
de expunere a rezultatelor (de exemplu în forma diagramei 
de la capitolul 3.2). Modelul şabloanelor poate fi optimizat 
dacă fiecare regulă ar primi o prioritate. Acest lucru ar 
avantaja algoritmul deoarece uneori expresiile nu sunt 
suficiente pentru a se potrivi cu modelul corect. Trebuie 
luate în calcul optimizările care conduc spre un mai bun 
echilibru între precizie şi timp. În acest scop se dorește şi 
evaluarea altor clasificatori, şi includerea mai multor 
facilități, în special semantice, precum şi extinderea 
utilizării metodelor de învăţare automată până la un 
echilibru precizie-timp.  

Tot în scopul de a optimiza modelul de analiză cu ajutorul 
regulilor, se poate recurge la combinarea cu un algoritm 
de învăţare automată pentru a filtra expresiile incorecte, 
dar şi pe cele corecte. O abordare bazată pe reguli este 
utilă pentru a identifica expresii fixe, dar dependentă de 
existenţa unui expert care să definească setul de reguli. 
Acestea se obţin ca rezultat a sute de ore de muncă
(analiză de text). Analiza gramaticală actuală este suficient 
de avansată pentru a identifica mai multe tipuri diferite de 
şabloane care să se muleze perfect pe o conversație 
obișnuită, dar limbajul natural nu este predictibil. 
Comunicarea în limbaj natural se remarcă în special prin 
variații şi incertitudini, apariţii ale expresiilor noi, fiecare 
domeniu având propriile expresii utilizate pentru a descrie 
o anumită activitate, obiect, etc. Includerea tuturor 
expresiilor în modelul bazat pe reguli nu numai că ar fi 
imposibil de realizat, dar şi dacă ar fi îndeplinită, ar pune 
problema unei complexităţi temporale foarte ridicate, în 
special datorată expresiilor inutile (Nu are sens să căutam 
şabloane specifice unui domeniu în analiza forumurilor 
dintr-un domeniu independent de acesta). Într-adevăr 
aceste câteva expresii, per domeniu, ar fi într-un număr 
mult mai mic decât al celor generale (pentru orice grup), 
dar ținând cont că pot exista extrem de multe grupuri, 
fiecare cu un limbaj propriu, se poate ajunge chiar la 
ambiguitate. Deși completarea algoritmului cu o analiză
de învăţare automată ar presupune încetinirea calculelor, 
aceasta ar fi de preferat completării listei de reguli cu toate 
posibilitățile, şi ar conduce la rezultate mai bune. 
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